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1 Getting Started in Lab 

1.1 Introduction 

● Read lab policies to familiarize yourself with the expectations and commitments to lab. 

● Read the appropriate semester syllabus for a full list of readings and lab meetings 

scheduled. 

● Check the evernote notebook entitled “Procedures for new RAs” for additional help and 

information. 

● For an overview of ongoing lab studies and their associated personnel click here. 
● Check the EMaC lab website. 

1.2 Research Assistant Status 

It is preferable that you officially sign up to be a research assistant in the lab. There are 

many ways to do so (see below) and if none of these options work for you, talk to Dr. Schotter 

to arrange a mutually beneficial alternative. Directed Study generates a course evaluation at 

the end of the semester. Please fill this out -- evals are the ONLY metric that the university uses 

to evaluate Dr. Schotter's teaching performance, which influences whether the university 

continues to employ her. You will also have the opportunity to make comments - people do 

read them. If you are not enrolled in Directed Study but would still like to provide an 

evaluation, you can fill out an Instructor Comment Form.pdf and submit it to the CNS Area 

Director (Dr. Joe Vandello). 

https://docs.google.com/document/d/1kFXSuyigypzpsG_u4aj8Ef-EefZcGnLQ51J-q2pvL9c/edit?usp=sharing
https://docs.google.com/document/d/19ge6gNv-AD0S8K30LeBnJrw7tS7mQohLZtYcoLPBSsY/edit?usp=sharing
http://emac-usf.com/
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1.2.1 Directed Study (PSY 4913; 1-3 credits) 

Undergraduate students can sign up for course credit through Directed Study. You must 

go to the Psychology Advising office to get a permit for this and they will check with Dr. 

Schotter for approval (give her a heads up before you go to the advising office so she knows to 

expect an email from them). 

1.2.2 Advanced Undergraduate Research Experience (IDS 4914; 0 credits) 

Under some circumstances, taking additional credits can be complicated for transcript 

or financial reasons. In this case, you can enroll in a 0-credit option through independent study. 

Additionally, students doing an honors thesis through the Honors College may sign up for this 

option. Make sure to discuss this option with Dr. Schotter and to ensure that you have enough 

time to dedicate to the lab. 

1.2.3 Volunteer 

Under very special circumstances, students may work in the lab with no official 

transcript record of such work (e.g., recent graduates). Make sure to discuss your commitment 

to the lab with Dr. Schotter. 

1.3 Access to Lab 

1.3.1 Key 

You will need to be given access to the physical lab (i.e., a key), the building for 

after-hours and weekend use (i.e., card swipe authorization), and the lab’s network drive (i.e., 

the “P drive”). Dr. Schotter will request access for you. You will need to tell her you USF netID & 

USF email address. (If you are a USF employee, you will also need to provide your USF 

employee ID). 

1.3.2 Google Drive 

Most of the lab is organized through the lab’s account in the Google universe (gmail, 

gcal, gdrive, etc.), ask Dr. Schotter for the password in person— memorize it and DO NOT save 

it on public computers. This account is also what is used for lab accounts in other services (e.g., 

Evernote, SR Research support forum, etc.). 

 

The account will have a separate calendar for each lab member— fill in the times that you are 

consistently unavailable to facilitate finding meeting times throughout the semester/summer. 

 

http://psychology.usf.edu/forms/PSYaccess.aspx
http://psychology.usf.edu/forms/PSYaccess.aspx
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Username: emac.usf (emac.usf@gmail.com) 

1.3.3 P-drive 

You should all be able to connect to the lab's P-drive (i.e., cloud storage for data and 

other sensitive files) from any workstation at USF (including the lab) as well as your own 

computers. On a USF desktop the pdrive should be listed in your file explorer under Computer 

(e.g. where you would locate a flash-drive). 

1.3.3.1 Mapping the p-drive on a USF computer (typically you can skip this) 

1. Right-click on Computer from Start Menu 
2. Select Map Network Drive 
3. In the Drive box, select an available letter (like P:) 
4. In the Folder box, type in the path  “\\forest.usf.edu\data\pdrive“  
5. Make sure the Reconnect at Logon box is checked 
6. Click Finish 

1.3.3.2 Remote Access to p-drive from home 

1. Download the VPN aka Junos Pulse Secure. (See VPN help for Windows or Mac).  
2. Once the VPN has been downloaded, connect. 

3. Then, for windows: open your computer file and go to “This PC” 

a. For Mac: see alternate instructions here. 
4. Click on the tab at the top titled “computer” 

5. Click “map network drive” 

6. Insert the correct pathway for your computer.  

a. Windows Path: \\forest.usf.edu\data\pdrive  

b. Mac path: SMB://usffs.forest.usf.edu/pdrive$ 

http://www.usf.edu/it/documentation/virtual-private-network.aspx
https://www.net.usf.edu/vpn/Windows/
https://www.net.usf.edu/vpn/MacOS/
https://docs.google.com/document/d/1mgH8dtiN1dvl24aqRdFrodk_pepy0B78gMOjcxkG-7M/edit?usp=sharing
http://usffs.forest.usf.edu/pdrive$
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c.  

d.  
7. You will then log in with your credentials. In order to do so, type in; FOREST\your netID 

and for your password simply use your password associated with your USF netID login.
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*Note: Connecting to the VPN means your internet connection is treated as if you were on 

campus; you can temporarily disconnect at any time; but when connected behave accordingly. 

1.3.4 Lab Computers 

All of the computers in lab should have the following programs installed: 

● Google Chrome 

● Firefox (where the consent form is bookmarked) 

● Experiment Builder 

● Data Viewer 

● Praat 

● R (& R Studio) 

● Python (& IDLE) 

● Side-eye 

(*if you cannot find or access these when you log-in to a lab computer let us know) 

1.4 Contacts 

1.4.1 Contact List 

Please add your contact information to the document, and refer to it if you ever need to 

directly message a lab member. 

1.4.2 Listserv Email 

Your email will be added to our ListServ account so that you receive emails sent by 

members of the lab. Dr. Schotter will add you— tell her which email you prefer to use. 

If you want to send emails to the list use emacLAB@listserv.usf.edu and note that if you reply 

to a message it replies to the ENTIRE LIST. 

https://docs.google.com/spreadsheets/d/1NjE-c0sy3nRcT15AwHDUh1BxU5k1EyaIuCvmUSVy84k/edit?usp=sharing
mailto:emacLAB@listserv.usf.edu
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1.4.3 Group Me 

Group me is the most used group chat for this lab. For a quick response, message 

anyone on there. To initially get added, ask anyone in lab. 

1.5 Accounts you need 

Every lab member will need the following accounts (more information about these 

specific sites may be provided in other sections of the manual- e.g. for extensive sona 

information see the sona section of the manual) 

1.5.1 SONA  

https://usf.sona-systems.com/  

You will need a separate sona researcher account from your participant account. We 

can request one for you. Once you receive an email to activate the account, follow the link to 

create your NEW researcher account. You may be required to use separate emails and login 

information to differentiate between the two accounts. See Sona Account Section 

1.5.2 Google 

You will need your own gmail as well as access to the lab gmail: emac.usf@gmail.com 

1.5.3 Evernote 

https://www.evernote.com/Login.action  

Use the password for emac.usf@gmail.com 

1.5.4 Collaborative Institutional Training Initiative (CITI) 

Training in the ethical conduct of research with human subjects. Follow the link below to 

create an account and take the course (1.5-2 hours, does not have to be in one sitting-- you can 

pause your progress and return). Once complete, send the certificates to Dr. Schotter, if you 

have already completed this before, send your original certificate (good for three years). 

 

CITI Program Certification  

1. when you go to the website, click on "register" 

2. fill in "University of South Florida" 

3. create a username and password 

4. select the social/behavioral investigator and key personnel (stage: basic course). 

5. **the course is free--if you are being asked to pay, you've done something wrong. 

https://usf.sona-systems.com/
mailto:emac.usf@gmail.com
https://www.evernote.com/Login.action
mailto:emac.usf@gmail.com
https://about.citiprogram.org/en/homepage/
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1.5.5 Academic Regulations Committee (ARC)  

ARC is the account for the IRB at USF. You will need to be listed on the IRB protocol as a 

key personnel. You will need to register for an account, fill in your information, confirm 

completion of CITI training, and upload your current CV/resume. Once registered, let Dr. 

Schotter know and she will send you an invitation to participate— you must agree to 

participate and an amendment must be approved before you can start collecting data. 

 

ARC Account Registration 

1. Click on “register here” 

2. Fill in your information (your role will be “study staff”) 

3. Once it has been approved by the ARC staff you will get an email confirmation 

4. Let Dr. Schotter know when this happens— she will make an amendment to add you to 

the study staff 

5. You will receive an email from ARC (after Dr. Schotter starts the amendment) to agree 

to participate in the study. In the email follow the link with the Project number, click it. 

Log in to ARC. You will see an Amendment, click it. On the left side of the screen you will 

then see an “Agree to Participate” Button. Once you click that you will be prompted to 

answer a few questions and upload a CV/resume. 

 

If you ever need to update your certification and other personal information, view your 

IRB profile. Which you can see on the main screen:

 

https://arc.research.usf.edu/Prod/Rooms/DisplayPages/LayoutInitial?Container=com.webridge.entity.Entity%5BOID%5B7271510F177D244BB2250977D0E1506A%5D%5D
https://arc.research.usf.edu/Prod/Rooms/DisplayPages/LayoutInitial?Container=com.webridge.entity.Entity%5BOID%5B7271510F177D244BB2250977D0E1506A%5D%5D
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Your profile contains information about you, your resume/CV, your training records, and when 

your certifications are set to expire. 

 

1.5.6 Qualtrics 

Login to Qualtrics through USF with your credentials. For more information on Qualtrics 

see this section of the manual. 

2 Starting a new Experiment 

2.1 Literature Search 

The USF library website is a great tool. Login with your USF credentials for full access to 

this resource. Use the PsychInfo database or google scholar. Once you find relevant articles, 

download the pdf. Then, navigate to the google drive-> Background Literature folder. Please 

https://webauth.usf.edu/login?service=https%3A%2F%2Fusf.az1.qualtrics.com%2FControlPanel%2F
http://www.lib.usf.edu/
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save all of your files to the appropriate folder for your topic (if one does not exist, feel free to 

create a new folder with an informative title). Please name all articles you save in the following 

format: Author et al. 2018 Condensed Title (with the first author and date published). This will 

make it easier to find later. 

2.2 IRB approval 

The USF Institutional Review Board accessible from the arc site. 
Here is a sample of some of the options you may choose when submitting a study to the 

IRB. Note: this is a sample with answers relevant to a specific experiment, you may need to 

select different options depending on the nature of your study. 

Some helpful hints for dealing with the IRB. 

2.3 Creating Stimuli (Sentences) 

Start by creating a google sheet in your experiment’s folder on the drive. Use the 

following websites to generate/assess properties of target words you may want to use. (You 

can also check with other RAs who may have stimuli similar to the ones you require.) Be sure to 

make a column in your sheet to record each important property of the stimuli that are relevant 

(i.e. target word length, cloze probability, etc.) 

Usually you will want to start with a list of words that meet your criteria; then, start 

another sheet to write possible sentences with those words. 

2.3.1 The English Lexicon Project (ELP) 

The ELP is a database published in 2007 that lists words with certain lexical properties; it 

can be used to compute lists of words with desired properties or it can tell you the properties of 

the words you input. The website is tempermental. 

Citation for ELP:  

Balota, D.A., Yap, M.J., Cortese, M.J., Hutchison, K.A., Kessler, B., Loftis, B., Neely,  

J.H., Nelson, D.L., Simpson, G.B., & Treiman, R. (2007). The English 

Lexicon Project. Behavior Research Methods, 39, 445-459. 

2.3.2 Latent Semantic Analysis (LSA) 

The LSA is a database that allows for comparisons of words for similarity. You can 

compare one (target) word to many other words here by selecting One-To-Many Comparison. 

Be sure to add a blank line between each word you wish to compare. 

Citation for LSA:  

Landauer, T. K., Foltz, P. W., & Laham, D. (1998). Introduction to Latent Semantic  

Analysis. Discourse Processes, 25, 259-284. 

https://arc.research.usf.edu/Prod/Rooms/DisplayPages/LayoutInitial?Container=com.webridge.entity.Entity[OID[AC482809EC03C442A46F2C8EEC4D75D3]]
https://drive.google.com/file/d/1qots2-rjJXs2SkCYu8aIq6yehtABEPtN/view?usp=sharing
https://docs.google.com/document/d/1wbUfit5zTVTQSYVLUk0eIxjQzX8yrrI08hV01wYFIpQ/edit?usp=sharing
http://elexicon.wustl.edu/query13/query13.asp
http://elexicon.wustl.edu/query14/query14.asp
http://elexicon.wustl.edu/default.asp
http://lsa.colorado.edu/
http://lsa.colorado.edu/
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To code your resulting data from an experiment that uses LSA , see this section. 

2.3.3 The Macroscope: A tool for examining the historical structure of language 

The Macroscope is a tool to interpret historical structure of language; it was designed to 

provide comprehensive analyses of historical meaning and requires little to no knowledge of 

linguistics. You can download the raw data of any figure as well. 

Citation for the Macroscope: 

Li, Y., Engelthaler, T., Siew, C. S., & Hills, T. T. (2019). The Macroscope: A tool for  

examining the historical structure of language. Behavior Research 

Methods, 1-14. 

2.4 Norming Stimuli 

Once you have sentences that you think will work for your eye tracking experiment, it is 

important to norm them with participants in your target population. The easiest way to do this 

is to get at least ten responses from people on Sona. Either make a google forms or a Qualtrics 

survey.  

See the sections in the manual regarding SONA, Qualtrics, & Google Forms, respectively. 

3 Programming an Experiment 

3.1 Experiment Builder 

Experiment Builder User Manual 

 

Steps for downloading Experiment Builder on a new computer 

3.1.1 Getting Help 

The Help in the Experiment Builder Program is searchable for key words and can be very 

helpful to check first, just press F1 in the program. There is an excellent support website for SR 

Research, which has forums where you can see what other peoples’ problems and solutions 

were, post your own questions to get answers, etc. SR-Research Support forum (username is 

emaclab password is the same as the google account). 

3.1.2 Creating your new project in EB 

Follow the step-by-step how-to create an experiment with helpful hints. 

 

http://www.macroscope.tech/
https://drive.google.com/file/d/0B5Zsqtn0ZMTpb1IxSzU0dWRjcFU/view?usp=drive_web
https://docs.google.com/document/d/1bLfkGS4qHLXJGx5INxho68NNVQ_A9pFeUKKKs3JqWZw/edit?usp=sharing
https://www.sr-support.com/forums/index.php?%20
https://docs.google.com/document/d/1Ay5R0AXaVEF6bP4bGmkfm303vcEoSSEDfMnVq8mlyaA/edit?usp=sharing
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Link to a bunch of pre-made Experiments on the SR Support Site with packages you can 

download (ready to use or edit). 

3.1.3 Test Running the Experiment 

1. Save the experiment 

2. Go to “Preferences” -> “Eyelink” and select “Dummy Mode” 

3. Go to “Experiment” -> “Test Run” and say yes to the message  

4. Once it runs a test it will give you feedback in the form of errors or warning messages. 

Errors are crucial and will halt the test run meaning that you cannot tell what happens 

beyond the point of error. You must fix errors! On the other hand, some warning 

messages can be ignored. 

5. Hint: if you don’t know what a message is trying to convey, check the help menu. 

3.1.4 Deploying the Final Experiment 

Once you have completed coding your experiment and all Test Runs come back good, 

it’s time to Deploy. Go to “Experiment” -> “Deploy” and save the file.  

● Hint: Go to “Preferences” to double check that you have unclicked “Dummy Mode”. You 

cannot deploy and run the experiment if it saved as “Dummy Mode.” 

● Hint: If you are editing the EB on a lab computer but not the tracker computer (which is 

where you really want to Deploy it) you should “Package” it, save it to a lab dongle. 

Transfer the file to the appropriate computer (the subject PC) and Deploy it there. Be 

sure to save the file to the desktop, do not run experiments off of the dongle! 

 

Once you deploy the EB, it will create a new folder which will have a different icon for 

the EB. When you go to run an experiment that's the icon you will use. Also note that within 

your new deployed folder is where the results files will save. 

3.2 Google Forms 

See the document for a few quick hints. 

3.3 Qualtrics 

Login to Qualtrics with your USF credentials. 

3.3.1 Getting Help 

A lot of times you can google your specific problem, but here are some good resources. 

https://www.sr-support.com/search?searchJSON=%7B%22keywords%22%3A%22conditional+voice%22%2C%22title_only%22%3Afalse%2C%22ignore_protected%22%3A1%7D
https://docs.google.com/document/d/1vywI2QI2NNvC2CzgkweZjbsTeOe3kw7dwwWfTao76lw/edit?usp=sharing
https://usf.az1.qualtrics.com/
https://www.qualtrics.com/support/
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3.3.2 Creating a Qualtrics Survey & Helpful Hints 

See the instructions and hints document. 

3.3.3 How to Import/Export Surveys to/from Qualtrics 

See the instructions. If you format a simple .TXT file as described you can append the 

trials to an existing survey or create a new one (codes for preparing the file here). You can also 

use .QSF files to share survey formats without sending response data. 

3.3.4 Combining Qualtrics Surveys 

See the instructions.  

3.3.5 Exporting Data from your Qualtrics Survey 

Once your participants have responded, you can go the Reports tab to view their 

answers on Qualtrics. 

If you need to export their responses for analysis, go to “Data & Analysis” and select 

Export as CSV. This will save the information as a zip file. Locate the zip on your computer, unzip 

it and upload the unzipped version to your folder in the google drive. Open it with google 

sheets. Then, you can add a sheet, and “Transpose” the data. On your new sheet, type 

=TRANSPOSE and go back to the original sheet and highlight everything. This will reorganize the 

horizontal responses into vertical format (which is visually easier and works for analysis like in 

R). [The function transpose does not exist in excel that’s why you do it in docs]. Then download 

it again to excel or CSV so that R can read it. 

https://docs.google.com/document/d/1jyyTn22towjjl1zvn-QxbCN6Gkcw1Fxi9D0HHCMAD8Y/edit?usp=sharing
https://www.qualtrics.com/support/survey-platform/survey-module/survey-tools/import-and-export-surveys/
https://www.qualtrics.com/support/wp-content/uploads/2015/04/Example.txt
https://www.qualtrics.com/support/survey-platform/survey-module/survey-tools/import-and-export-surveys/#PreparingAnAdvancedFormatTXTFile
https://www.kent.ac.uk/psychology/technical/pdfs/qualtrics-multiple-surveys-in-one.pdf
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3.3.6 Editing Count of Randomized Blocks in Qualtrics 
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& see the Qualtrics help page. 
 

3.4 Sona 

https://usf.sona-systems.com/  

3.4.1 Setting up a SONA Account 

Researchers and subjects are treated differently with separate accounts; everyone 

running experiments will need a separate login. If you do not have any account, we will request 

one for you by emailing the SONA staff. Once you get an email response with your account 

information please reset your password. 

If you use the same email and password for both your participant & researcher accounts 

then it will allow you to switch between the two after the login screen. 

3.4.2 Using your SONA Account 

Once you have an account and have logged in, you will be brought to the main page of 

SONA which has the following tabs: 

 

https://www.qualtrics.com/support/survey-platform/survey-module/survey-flow/standard-elements/randomizer/
https://usf.sona-systems.com/
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● My Studies: This will list all of the experiments on which you are specified as a 

researcher. This is where you will go to add timeslots and administer credit. 

● All Studies: All studies that are listed to participants, in alphabetical order. 

● Add New Study: Access the form to request the addition of an experiment to the 

system. 

 

 

3.4.3 Adding a Study to SONA 

Follow the instructions. 

https://docs.google.com/document/d/1EE-f83xTALsR_mKitAd73P-PJX3ogz8WQTlpAm81YaM/edit?usp=sharing
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3.4.4 Changing IRB Status for SONA 

As IRBs only approve studies for a year at a time, you will need to renew to keep 

collecting data (on the arc website) and let SONA staff know when your studies renewal is 

approved. 

1. Go to your SONA study.  

2. Then click Study Menu -> Change Study Information.  

3. Where it says IRB Approval Expiration, send a request to change this.  

4. Upload the file with the new expiration date. (This is the “Continuing Approval” letter 

which you can find directly on the IRB website or in the IRB folder of the pdrive). 

5. Hint: the Approval Code remains the same for continuing reviews. Only change the date. 

 

3.4.5 Adding Timeslots on SONA & Google 

See instructions. 

3.4.6 Granting Credit on Sona 

Granting credit to participants on sona means editing that participant’s timeslot. See the 

instructions. 

3.4.7 Special Circumstance (Granting/Assigning Credit Directly) 

If you wish to grant credit to a participant who, for whatever reason, did not sign up for 

a timeslot but participated in your study, you can assign them a slot yourself. 

1. Add a timeslot to sona as you usually would (perhaps for an obscure time so no real 

participant signs up for it while you’re doing this). 

2. Click “Modify” on the timeslot 

https://docs.google.com/document/d/19sZxBVnHu82ID-6P8wV-B1qMX2ocX-SxgZXWAeu74y4/edit?usp=sharing
https://docs.google.com/document/d/1VTH8FaVJq5Ig5TT9iXUH_8LFQsaFTWkct-Cb4IZvv5c/edit?usp=sharing
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3. Search for the participant you wish to grant credit to and sign them up yourself. 

4. Then “Modify” the updated timeslot to grant credit as you typically would. 

3.4.8 Linking SONA and Qualtrics 

Sona allows for linking to an external webpage to run an experiment online. 

Sophisticated survey-type studies can be created through qualtrics and you can set it up so that 

Sona automatically assigns credit if the subject completes the survey. See the instructions. 
To test if the automatic credit granting works, follow these instructions. 
 

3.5 Amazon Mechanical Turk (mTURK) 

For sentence norming and other repetitive off-line tasks, we can use mTURK an online program 

hosted by Amazon where workers/participants complete “hits” in exchange for $1 an hour. For 

an overview of mTURK see here. For information on pricing/fees. 
Use the EMaC lab’s Amazon account. 

You can write html code to structure your hit or, 

You can link mTURKers to your Qualtrics survey by adding just two lines on your hit: a 

survey link and an input box for them to respond with a custom survey code generated by 

Qualtrics. Follow these instructions. See below: 

https://www.sona-systems.com/help/qualtrics.aspx
https://www.sona-systems.com/help/integration_test.aspx
https://michaelbuhrmester.wordpress.com/mechanical-turk-guide/
https://requester.mturk.com/pricing
https://bradylab.ucsd.edu/ttt/
http://brentcurdy.net/qualtrics-tutorials/link/
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3.6 R Shiny (Publishing Shinies.io) 

Cheat sheet for working with R shinies 

 

How to publish your completed shiny on shinyapps.io 

3.7 EyeTrack (for Tracker A) 

The Eyetrack program reads a .script file that is a text file with specific formatting. The 

most efficient way to create this file is to turn a stimulus file into a formatted file with a Python 

script. 

UMass EyeTrack Manual located here. 

https://drive.google.com/file/d/173icZ4oC6zB55g3TFAvhgkLyDaLDOgnZ/view?usp=sharing
https://shiny.rstudio.com/articles/shinyapps.html
https://drive.google.com/file/d/1knqyfw3fcAzIC7pbLb15BgK7AstBcmoe/view?usp=sharing
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3.8 Python for programming an experiment 

3.8.1 Getting Help 

● http://pythontutor.com/ allows you to edit code and chat with other users. Anyone you 

allow in your chat room can edit with you. It’s like the google docs of coding! 

● In lab we have Donaldson’s Visual Quickstart Guide to Python (Second Edition) 
○ Part of his third edition is available as a pdf here & on the google drive. 

● Google offers class in python here. 
● You can check the forums & FAQ page here. 
● In python, type help() at a prompt  

3.8.2 Adding Python to PATH 

In order to run Python on the lab computers you need to add it to the PATH (i.e., where 

the computer looks for files and programs). You will only need to do this once, the first time 

you want to use python and then you can just run it like you normally would from then on. See 

the instructions. 

3.8.3 Creating a python script 

1. Launch IDLE 

2. File-> New File 

 

3. This fresh window is where you can type and edit code. 

4. Remember to save and name it.  

a. Hint: It should now be a .py file. This contains your “source code” so it’s known 

as your “source file”. 

http://pythontutor.com/
http://ptgmedia.pearsoncmg.com/images/9780321929556/samplepages/0321929551.pdf
https://developers.google.com/edu/python/
https://www.python.org/community/
https://docs.google.com/document/d/1ChpjmKrZJ2plGOyxHQnIcxwU5cflDoSQwAxwMsYlTv0/edit?usp=sharing
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5. Start your script by pointing it to which files to read. Create a variable (in the below 

picture we create rf1), assign it with the equal sign, tell it to “open” the appropriate file 

name. 

6. Hint: the name you tell python must be the exact name of the file in your computer, 

rename it if you must. 

 

7. & tell Python to write your output to a file using the w function. 

3.8.3.1 Variables 

● Variable names must only be composed of numbers, letters, or underscores (no spaces 

or special characters allowed) but the first character can’t be a number 

● Case sensitive 

● Don’t use Python’s keywords/function words in your variable names (you’ll confuse 

python!) 

3.8.3.2 Assignments 

Similar to R code, you must create variables and define them. i.e. x = 5 or var_1 = cat 

This takes whatever is on the left side of the equal sign (e.g. x) and creates a variable with this 

name; it also takes what is on the right side of the equals and makes that the value of your new 

variable. Thus, in this example you create the variable x and assign it the value of five. 

3.8.3.3 Comments 

Use a hashtag # or several to include comments to yourself that Python will ignore. 

3.8.3.4 White Space or Code Blocks 

In Python, the white space and indentations are informative to the program. Anything indented 

under another line will run within that “block”. Everything in a block must be indented by the 

same amount (commonly four spaces). This is not just an aesthetic choice. 

3.8.3.5 Loops 

To repeatedly execute a block of code, use a loop. 
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3.8.4 Running python scripts from the command line 

1. Go to the start menu and click on the folder Accessories 

2. Click on Command Prompt 

3.  Navigate to the folder with your python script and files 

a. To go to a different drive (e.g., P drive, C drive) type the letter and colon (e.g., P:) 
and then hit Enter 

b. To change folders within a drive type cd and then your file path (e.g., cd CAS\PSY 

Schotter Lab\Experiments\EyeTrack Programming)  
i. You can find the exact path to copy and paste if you right click on a file in 

the windows explorer and click Properties. The path will be in the 

Location field 

4. Type python and the name of your python script (e.g., python EXP_creator.py) and hit 

Enter 

5. If there are any errors they will show up in the command prompt window 

3.8.5 Running python scripts to check for errors and make edits from IDLE 

1. Make sure all of your files are together in the same folder. 

2. Right click on your Python file in the file explorer window. Edit with IDLE (if there are 

multiple Python’s downloaded to your computer, i.e. version 2.7 & 3.6, choose the 

appropriate one). 

3. It will open a new window which shows you the code. 

4. Press F5 on the keyboard to run it and see any errors 

5. Once you run the Python file it will output a .Script file. That .script file can be used by 

EyeTrack to run experiments on Tracker A. 

4 Pilot Testing a Study 

A lot of stimulus creation, cloze tasks, norming, and other Qualtrics surveys bring you pilot data. 

 

4.1 First time Tracker Training 

If you’re new to lab, you should complete this check-list of training/practicing before 

you’re ready to run participants on your own.  

4.2 Test running an experiment with EyeTrack on Tracker A 

1. Prepare your Python Script 

https://docs.google.com/document/d/1_blqpbUATQjs5DcXVmHQ7hTYftCJEGs2wXoO_TafHcM/edit?usp=sharing
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2. Save it on a dongle 

3. On the Subject PC Desktop, open the Liz folder->EMaC folder. Within that, create a new 

folder entitled your experiment. 

4. Move your .script file from the dongle to this folder. 

5. Double click the EyeTrack.exe application on the Desktop. 

6. Go to File->Open 

7. Once you open your script there should be three sections to the window. 

8. Select one of the Trials you want to view from the middle section of the window. 

9. Click Change in the middle section underneath. It will open two new windows where 

you can preview the experiment display screen. 

10. Hint: For any study with a gaze box to initiate the trial, you will see a green square on 

the left of the screen (this is the black gaze box you are used to). 

11. The squares surrounding each letter or word (depending on your choice) mark interest 

areas. 

12. For studies with display changes, you will see a green vertical line running across the 

screen at the point where the gaze will trigger the screen change. Hint: check that for 

each display change trial, the line should be at the end of the pretarget word (before the 

space before the target word). 

a. If any of the lines are in the wrong place, go back to your data source and check 

that you calculated the number of characters from the beginning of the sentence 

to the end of the pretarget word correctly. Make necessary changes to the 

sentence or calculation; re-run the Python script, add the new script to the 

Subject PC. Check again. 

b. Hint: you can flip back and forth between the two sentence versions by 

navigating from the second window. 

13. Check that the preview screen clearly shows the gaze box, interest areas, and that all 

information from the stimulus fits on one line without running off the screen. 

14. Finally, on the main eye track window, click Experiment->Validate. The program will 

check for any glaring errors (such as missing data). 

a. When it’s done a new window will declare “Experiment Validated Successfully” 

5 Getting Familiar with the Trackers & Assessments 

5.1 Eyelink OS Screen Guide 

See the guide. 

https://docs.google.com/document/d/1fmAKDcQ_ypeqHDQ5EDxhn2yvEPNE_uhcg20xMzJnqlk/edit?usp=sharing
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5.2 Tracker A Specifications 

The computer screen used for Tracker A is approximately 40.5 cm wide by 30.5 cm tall.  

It has a screen resolution of 1024 x 768 pixels. 

 

To write a materials/apparatus section of  a paper use the following format: 

Eye movements were recorded with an SR Research Ltd. Eyelink 1000  eye tracker (sampling 

rate of'1000 Hz) in a tower setup that restrained head movements  with forehead and chin 

rests. Viewing was binocular, but only the eye movements of the  right eye were recorded. 

Subjects were seated approximately 60 cm away from an HP  p1230 CRT monitor with a screen 

resolution  of 1024 x 768 pixels and a refresh rate of'150 Hz. Text was displayed in black, 

14-point, fixed-width Courier New font on a white background. Sentences were always 

displayed in the vertical center of the screen in one  line of text, and 3.8 characters subtended 

1º of visual angle. Display changes were  completed, on average, within 4 ms of the tracker 

detecting a saccade crossing the invisible  boundary, which was located at the beginning of the 

space preceding the target word. 

5.3 Tracker C Specifications 

The computer screen used for Tracker C is approximately 40 cm wide by 30.5 cm tall.  

It has a screen resolution of 1024 x 768 pixels. 

 

To write a materials/apparatus section of  a paper use the following format: 

Eye movements were recorded with an SR Research Ltd. Eyelink 1000plus eye tracker (sampling 

rate of 500 Hz) in remote setup. Head movements were not restrained but rather measured via 

a sticker placed on the participant's forehead that measured and corrected for them. Viewing 

was binocular, but only the eye movements of the right eye were recorded. Subjects were 

seated approximately 60 cm away from an HP p1230 CRT monitor with a screen resolution of 

1024 x 768 pixels and a refresh rate of 150 Hz. 

5.4 Language Assessments 

See the scoring and instructions document. 
For additional help, reference this powerpoint. 
Print a packet of the assessments you will need for each participant (these are available 

on the pdrive, P:\CAS\PSY Schotter Lab\Experiments\Assessments\All Assessment Docs ).  

https://docs.google.com/document/d/1rWKkcpr6STfbGShet1yH2g7X6o5yCwyvi42XqUmpgzk/edit?usp=sharing
https://drive.google.com/open?id=1tjR77HnWzGzsWymTijih6FAIrP7gNOsF
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5.4.1 General Introduction for assessments 

“This part of the experiment will consist of a series of exercises to assess your 

vocabulary, creativity, spelling, comprehension, and other language related abilities.  

 

These assessments are meant to capture a wide range of variability in performance so 

some items might be very difficult. This is necessary to produce some errors even among highly 

intelligent, college-educated individuals, so please try your best but don’t be surprised if there 

are some words or answers that you do not know. 

 

Also, for many of these assessments there is no single correct answer so just give the 

best response you can think of. And of course, we will not share the results of your individual 

performance with anyone, so try your best but do not worry about how you feel you did.  

 

Any questions? Okay, let’s begin.” 

5.4.2 Digital Voice Recorder 

The equipment we use to record sessions of language assessments has more 

information available online 

https://www.olympusamericaprodictation.com/product-category/portable-dictation/  

6 Recruiting participants 

If you are recruiting participants outside of the SONA system, you should contact them via the 

lab email (emac.usf@gmail.com) & all of your recruitment fliers should indicate this. If you’re running a 

study with very specific inclusion criteria it’s also good to tell people to use a certain subject line in their 

email (e.g. “music study” for exsightsing) so that they are directed to the right research assistant.  

 

More generally, all reading studies in this lab have the same inclusion criteria (i.e. normal vision, 

native english speakers, etc.). To screen potential participants in a uniform fashion, ask anyone who 

emails the lab to respond to a brief series of demographic questions. These include: 

1. What is your name? 

2. How old are you? 

3. Are you a native English speaker? 

4. What other languages do you speak/read? 

5. Have you ever been diagnosed with a reading, speech, or learning disorder? 

6. Do you have normal or corrected-to-normal vision? (can you read a computer screen comfortably) 

7. Do you wear glasses or contacts (hard or soft)? (Please list all) 

8. Are you able to come to the lab (PCD 3122 on the USF Tampa Campus)? 

9. When is the best time for you to come to the lab in the next week or two? 

https://www.olympusamericaprodictation.com/product-category/portable-dictation/
mailto:emac.usf@gmail.com
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10. What is the best phone number to contact you? 

11. What is the best email address to contact you, SONA email address if applicable? 

12. Are you a USF employee? 

 

In the emac gmail account, we have a saved response format that you can easily send to anyone. To do 

so, 

1. Login to emac.usf@gmail.com 

2. Select an email to respond to & click reply 

3. In the bottom right corner of the template, open the menu as shown below 

 

4.  click “canned responses” 

5. And under the “Insert” tab, select “Paid Subject” 

 

mailto:emac.usf@gmail.com
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6. It will automatically insert the appropriate questions 

 

7. And you can modify it as you see fit before sending 

 

Subjects recruited outside of sona must be compensated for their participation via cash. Make 

sure to fill out the payment log and recount the cash reserves after you finish running participants with 

the door locked.  

If the paid participant is a USF employee, you will need them to fill out an Employee Payment 

Form as well which can be found in the third drawer of the filing cabinet; this will go towards their 

federal income tax. The PI (Liz) is the requestor, you need only fill out the middle section, with as much 

Employee Information as possible, they can login to GEMs on the lab computer if they can’t remember 

their GEMS ID (note that this is a code of numbers, it is not their netID). 

7 Scheduling Participants for a study 

1. For in-lab studies, always check the lab google calendar for availability.  

2. Open timeslots on SONA. See how here. 
a. Hint: For online studies you will not need to specify a location and you can run 

multiple people for the same “time”. 

3. For in-lab studies, be sure to reserve the time on the google calendar (specifically under 

the Tracker A or C room). 

4. For online studies, open as many timeslots as you expect you will need (you can always 

add additional ones later). 

https://drive.google.com/file/d/1ENEabrnrn1pHn1bZQhFF3VoRmwxOZ3s1/view?usp=sharing
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8 Running Participants for online studies 

Once you open the appropriate number of timeslots on SONA, check back in 

occasionally to see progress and ensure participants are getting credit. Also check the Reports 

on Qualtrics to make sure information is being gathered correctly. These are all things you 

should work out in a pilot test but be thorough. 

 

9 Running Participants for in-lab eye tracking studies 

9.1 Consent 

In EMaC lab, we have different consent forms which specify different parameters, IRB 

numbers, and compensation rates. Always be sure you are giving participants the appropriate 

consent form for your study. A complete list of approved consent forms is located here. It is 

also linked on our website at https://emac-usf.com/resources/ for your convenience. 

 

We suggest you bookmark the consent form you plan to use the most often on the 

computers for quick/easy access when subjects arrive. To do so, log on to the lab computers, 

use your USF NetID and password. Add FireFox to the Pinned programs bar at the bottom of the 

desktop (you will only need to do this once—the first time). Set-up Firefox home screen to be 

the you will use most often (e.g. the EMaC in-lab Sona participation Consent Form. Make sure it 

is in the "preview" mode (to do this click the eyeball icon at the top).  

9.2 Subject Logs 

In lab there is a binder on the bookshelf labeled “Running Log.” Experiments are 

alphabetically ordered.  

 

Locate the coversheet of the appropriate experiment and its associated log/debriefing 

form. You can remove those items from the binder and bring them into the eye track room with 

you but leave the binder out for other RAs to access. On the log you will be prompted to list the 

coded number specific to the participant, which RA is running the experiment, etc.  

https://docs.google.com/document/d/1BBobtiRLST0NW7Ox_zi-Xx3jLuV_P8v8YCXNgNW4jgI/edit?usp=sharing
https://emac-usf.com/resources/
https://goo.gl/forms/Vlte6A6nsyG5bjYi1
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Make sure you base naming and condition on the coding scheme found on the 

cover-sheet. Be sure to take note of anything odd that happens during the experiment and 

record participants’ responses to the debriefing questions at the end. 

 

If you need to print a new log, there is a template in the Google Drive Admin folder. 

Download it, edit it for your study and save the edited form to your experimental specific folder 

on the drive. 

 

9.3 Procedure 

1. Check the person’s name to ensure that they are here for the correct study. 

2. Have them read over the consent form on the computer. 

3. Record information in the subject log. 

4. See the specific instructions in the how-to guide. Additional instructions available in 

evernote.  

9.4 Calibration and Validation 

See the hints/instructions for calibrating. See troubleshooting Q&A. Or check Evernote. 

9.5 Mouse Simulation for Tracker A 

If you ever need to end an experiment early without completing all trials, you can use 

the mouse simulation to exit the experiment. See the instructions. 

9.6 Disable Tracker Beeping 

Occasionally, Tracker A (after an update or hard-drive change) will have an annoying beep, to 

rectify the issue try these steps. 

10 Saving Data/Backing up the Tracker Computers 

We have external hard-drives to backup information from the display computers. See the 

company’s manual for info on backups for Windows 7 & newer. The display computer has to be 

logged-in and not asleep in order to execute the backup. 

 

For Windows XP you may need to manually backup data, see here. In the event that you need to 

schedule a task that you can write the commands, see how to use the command prompt. And xcopy 

links 

https://docs.google.com/document/d/1GYyVfio8i2x8SoO9YxRPQIWL9W3-hZyUbEHKLqVQUxA/edit?usp=sharing
https://www.evernote.com/shard/s718/nl/167652058/9f2a6e5e-829d-4e93-99b2-e13a5acc1d9f?title=A%20Guide%20to%20Running%20the%20Experiment
https://docs.google.com/document/d/1_qKcncZLztgB129TGbBdzYE2qo7bRUf9pr5YSvymbro/edit?usp=sharing
https://docs.google.com/document/d/1iDzFCZYYkECmoZ3uLmeLpSOFrD3V00dLPs8AyaOyYU0/edit?usp=sharing
https://docs.google.com/document/d/1f5ufydbG545F-IQnwLoTFUkj-5a9xreUQZh_9UgPkVo/edit?usp=sharing
https://drive.google.com/file/d/1D9Zn7QKAE2XqRNSs2DH9Xkowbus7F_I_/view?usp=sharing
https://itstillworks.com/back-up-files-windows-xp-external-hard-drive-9252.html
https://www.online-tech-tips.com/computer-tips/how-to-use-dos-command-prompt/
https://commandwindows-com.cdn.ampproject.org/v/s/commandwindows.com/xcopy.htm?ezoic_amp=1&usqp=mq331AQCCAE%3D&amp_js_v=0.1#referrer=https%3A%2F%2Fwww.google.com&amp_tf=From%20%251%24s&ampshare=https%3A%2F%2Fcommandwindows.com%2Fxcopy.htm
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For Programs that require the computer to be awake in order to run, you can use the Task 

Scheduler to tell the computer to wake up at certain times following these instructions for Windows 7 or 

these for Windows XP. 

11 Data Processing/Analysis 

11.1 Google Sheets Life Hacks 

See the list of life hacks and formula breakdowns. Feel free to add your own knowledge 

to the list. Or google the problem. 

11.2 Data Viewer 

Data Viewer User Manual  

 

Follow these general guidelines for creating reports of your eye tracking (edf files from 

Tracker C) in data viewer. 

11.3 Eye Dry 

To get data from Tracker A from an ASC to a da1 to an IXS to a readable file follow these 

instructions. But first drag and drop your EDF files (that come straight off the trackers) over the 

edf2asc.exe application to convert edf to asc. You can find this application on the pdrive in the 

software and data processing folders. Hint: You don't need to actually open it, just drag the file 

over the application and release it. 

https://www.thewindowsclub.com/wake-up-computer-from-sleep-windows
https://www.dummies.com/computers/pcs/how-to-create-a-task-in-windows-xp-scheduled-tasks/
https://docs.google.com/document/d/1JVwhe8NmKPHxKvEz6iTH4G2seE0-WCet10oD391R7RQ/edit?usp=sharing
https://drive.google.com/file/d/0B5Zsqtn0ZMTpam9ySFdMWl9FeGc/view?usp=drive_web
https://docs.google.com/document/d/1zI3rhkOX8FJo22nPpjvXdGcdpHythzAv1O8PpMDhALA/edit?usp=sharing
https://sites.google.com/view/emac-usf-asc2ixs/home
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11.4 SideEye 

A new program in development to potentially shrink the process with eye dry down to 

one step executable on python. 

Check github “side-eye” by bdillon 

For a how-to guide see here. Or here.  
 

Here is how to get asc to da1 which can be processed in SideEye. 

11.5 R Code 

https://www.r-project.org/  

11.5.1 Downloading R 

https://cran.r-project.org/bin/windows/base/  

11.5.2 Getting Help 

The book R for Data Science by Hadley Wickam provides excellent interactive, online 

tutorial with examples for tidying and visualizing data that you can follow along with. 

 

Lynda.com has videos regarding data wrangling in tidyverse. 

To log in to Lynda wirth USF credentials follow the instructions, also available here. 
 

The book Learning statistics with R: A tutorial for psychology students and other 

beginners by Daniel Navarro is an online stats textbook with examples; also available here. It 
covers more theoretical and statistical stuff than the Wickam book. 

 

The emac google drive also has a folder of R information.  

11.5.3 Getting Started 

See this brief run down to get yourself acquainted with R studio. See this chart of key 

codes. 

 

Note that there are certain style conventions that allow for the easy sharing of code 

between coders; for a full guide of coding etiquette, see Wickham’s post. 
 

https://docs.google.com/document/d/1YHU2v2xnlqsUlWFzQKgLqu7tUXI_miNS7E_EasVEKCU/edit?usp=sharing
http://sideeye.readthedocs.io/en/latest/sideeye.data.html
https://docs.google.com/document/d/1KiyVNiMDhDPU1mflalgjsIkBX6VawekKRjKZlfAF96U/edit?usp=sharing
https://www.r-project.org/
https://cran.r-project.org/bin/windows/base/
http://r4ds.had.co.nz/index.html
http://r4ds.had.co.nz/index.html
https://www.lynda.com/search?q=tidyverse
http://www.usf.edu/hr-training/documents/lyndaaccess.pdf
https://drive.google.com/file/d/1iBaVycV6A60qaRSfUEQVTrl8Onoj7S5U/view?usp=sharing
https://health.adelaide.edu.au/psychology/ccs/docs/lsr/lsr-0.5.pdf
https://drive.google.com/file/d/11uavv3UpYcmyClJAh6Vzeyrgzs7h0oBZ/view?usp=sharing
https://drive.google.com/file/d/11uavv3UpYcmyClJAh6Vzeyrgzs7h0oBZ/view?usp=sharing
https://drive.google.com/file/d/11uavv3UpYcmyClJAh6Vzeyrgzs7h0oBZ/view?usp=sharing
http://www.fon.hum.uva.nl/paul/lot2015/Navarro2014.pdf
https://drive.google.com/drive/folders/0B5Zsqtn0ZMTpR0lKU0dJMlRzSUE
https://docs.google.com/document/d/1T9znBsMDTAZu1IwRaT2qg6Av5mJ2ji51OUSQseInStg/edit?usp=sharing
https://sites.google.com/view/learning-r-code/home
https://style.tidyverse.org/
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11.5.4 Installing Packages 

Before you can use R successfully, you will need to install packages of functions to use. 

You can do this many ways.  

● Type: install.packages(“”) with the name of the package in quotes, i.e. 

install.packages(“tidyverse”) then run this line by pressing cntrl enter. 

● Or in the bottom right portion of R studio click “Packages” -> “Install”, type the names of 

the packages in a list, & click “Install” 

● Or at the top menu click “Tools” -> “Install Packages” and type the names of the desired 

packages 

 

Once you download a package on a given computer you will need to call it in to the code 

by typing: library() with the package name, i.e. library(tidyverse). You only need to install the 

package once but you need to call it via the library function at the start of any code you use it 

in. 

 

Some common packages we use in this lab are “plyr” “tidyverse” & “lme4” (always load 

the plyr function before tidyverse to ensure that dplyr (within tidyverse) works properly. If it’s 

your first time trying to install tidyverse and it’s causing errors, first install “stringr”. 

11.5.5 General Cheat Sheet to functions  & commands 

See this general cheat sheet regarding a number of r functions. To download additional 

cheat sheets, see the rstudio website. 

11.5.6 tidyverse 

R can now operate in tidyverse which makes data viewing much cleaner and the code 

simpler. Before starting your main R code, be sure to run the tidyverse Library by telling R: 

library(tidyverse).  

 

Hint: If you are using ddply (an automatic part of tidyverse) and plyr, you will actually 

need to load library(plyr) before library(tidyverse). 

 

Once you load your libraries, set your working directory: 

setwd('P:/CAS/PSY Schotter Lab/Experiments/YOUR_EXPERIMENT_FOLDER’) 

Hint: macs and windows have slightly different paths 

 

https://drive.google.com/file/d/0B4yLNb0rTrLNUTZXMDZaUzE0U2M/view?usp=sharing
https://www.rstudio.com/resources/cheatsheets/
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Hint: comments in R Script are written by putting hashtags in front of the text like this: 

#comment or ##comment. In R studio they will turn green and R will know not to run this line 

as code. 

 

Then set the path to the exact folder where your data files are stored. In this example, I 

have a folder of “ResultsFiles” within my experiment folder. 

data_path <- "ResultsFiles"  

 

Now pull in the data from that specific folder: 

files <- dir(data_path, pattern = "*.txt")             # get file names 

data <- data_frame(filename = files) %>%        # create a data frame 

mutate(file_contents = map(filename,               # read files into 

                    ~ read_tsv(file.path(data_path, .)))            # a new data column 

  )  

data<-unnest(data)                                          #put the data back together 

 

Hint: You can tell R to treat “Missing Data” as actually negligible by making it “NA”:  

data[data=="MISSING_DATA"]<-NA 

11.5.7 ggplot 

See the cheat-sheet to ggplot2. It is used to make graphs. 

 

Hint: As your plots get longer and more complicated, you can clean the code visually by 

separating each component with a + and then skipping to the next line. 

 

11.5.8 dplyr 

See the cheat-sheet for dplyr. It is used for data transformation. 

https://drive.google.com/file/d/14D-YPLLJrF2OVuxMyO7lMUjMcxNmalay/view?usp=sharing
https://drive.google.com/file/d/1IJl4vxRR8CzpQ-9Ti8lZn_ztRhAFhM-2/view?usp=sharing
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11.5.9 glmer 

11.5.10 purrr 

See the cheat sheet for purrr. It is used to apply functions. 

11.5.11 R-markdown 

R-Markdown allows you to run R-code and “knit” it together into a document(i.e. .pdf or 

.html) that can be easily referenced and shared. The knitted document is comprised of lines of 

actual R-code, the associated output of those lines when run, and any comments you choose to 

include. 

As a reminder, follow Wickham’s style conventions to facilitate sharing with other 

coders. 

See the quick how-to. 
See the cheat sheet graphics in the google drive. 

11.5.12 R scripts for processing data 

As a lab we have developed some R scripts to run certain analyses. 

● IXS: processing IXS files, modify and use the “EXPProcessingIXS.R” script 

● Survival analyses: modify and use the “SurvivalStuff.R” script 

11.6 Bayesian Statistics 

Unlike frequentist stats, you can use Bayes to find evidence to support the null 

hypothesis. For a brief introduction to Bayes Factors see here. 
 

For running Bayes in R, see here & here. 

11.7 From Qualtrics to Google Forms 

For norming and cloze data you can export responses from Qualtrics to excel and upload 

them to google sheets to transpose pages and visualize data in pivot tables. 

11.8 Python scripts for processing data 

As a lab we have developed some python scripts to run certain analyses. 

● LSA: to process LSA values from participant responses, follow the instructions, use the 

LSATool.py script located in the Software folder of the pdrive. 

https://drive.google.com/file/d/1Pg0MChJL3vLlyW4cNU5DtbgBYqykxtln/view?usp=sharing
https://style.tidyverse.org/
https://docs.google.com/document/d/1q54ajNKxLnvmo7JyPqLnGR5jN-Pvo3a-eISjh84xt5U/edit?usp=sharing
https://drive.google.com/file/d/1yxbFUUeRkZzngBk2ciOWTqH21gjnkZea/view?usp=sharing
https://www.cogsci.nl/blog/interpreting-bayesian-repeated-measures-in-jasp
https://rpubs.com/lindeloev/bayes_factors
http://bayesfactor.blogspot.com/2014/02/bayes-factor-t-tests-part-2-two-sample.html
https://drive.google.com/file/d/1GkCJ0IOu9IvpeWXkbiiDWDZWCMNKKM6l/view?usp=sharing


37 

● CNT: To create a CNT file that indicates the length of your regions of interest, follow the 

instructions, and use the CreateCNT.py script located in the Software folder of the pdrive. It will 

prompt you to upload your stimulus set. (Hint: CNT files are needed to run Eyedry & Timdrop.) 

11.9 JMP 

11.9.1 Getting Help  

Check the book JMP Essentials: An Illustrated Guide for New Users (Second Edition) by 

Curt Hinrichs and Chuck Boiler. There is a physical copy available in lab on the shelf. 

ISBN: 978-1-61290-785-7 

11.9.2 Downloading JMP 

JMP has already been downloaded on the two lab computers but if you need to 

download it somewhere else check USF’s website. 
The first time you go to use JMP on a lab computer you will need to provide it a license 

code. Find the JMP software and open it. When it prompts you for a license, go to the p drive -> 

software ->JMP ->Windows and select the file with a long name. Do not enter anything in the 

Administrator name fields. Just press OK. Now you should be able to open JMP. 

11.9.3 Using JMP 

See the how-to document. 

 

12 Audio Coding  

12.1 How to Read a Spectrogram 

See the website for spectrogram diagrams.  

12.2 Praat 

Download Praat. For usage, see the how-to document. 

https://drive.google.com/file/d/1ekf8d1TuGnppaibCEv99jcc3-TyLBQ23/view?usp=sharing
https://software.usf.edu/all-software
https://docs.google.com/document/d/18WLhYY8shVoZRVp-wANtnkL0ww2AmNWu3U6VRS8IwBU/edit?usp=sharing
https://home.cc.umanitoba.ca/~robh/howto.html
http://www.fon.hum.uva.nl/praat/download_win.html
https://docs.google.com/document/d/1ARCrc01wkPEPZURsun5YddB__VcjMqyNPxE7MJWbs0U/edit?usp=sharing
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13 Presenting Research 

13.1 Posters 

Printing at the USF print shop can take 2-4 days. Email them at: to submit a poster or 

talk to them in their office on the first floor of the MSC. 

 

Pro-copy on Fowler needs 24 hours advance notice to print and costs about $56 

13.2 Talks  

13.3 Conferences 

USF holds research expos every year including 

● The PsychExpo (by the Psych Department/Vickey Phares) 

● The OUR Research & Arts Colloquium (by the Office of Undergraduate Research) 
● Annual Florida Psycholinguistic Conference 

 

 

http://www.usf.edu/undergrad/undergraduate-research/

